
 

 
 
 
 
 
 
 
 
 
 
 

IA Style PowerCamera Suite 
Quick Installation Guide 

 
 
 
 
 
 

 
 
 
 
 
 

July 2002 
www.iastyle.com 

 
 



Information in Action  —  www.iastyle.com
                                              

 

Copyright and Contact Information 
IA Style, Inc. has made every effort to verify the accuracy and completeness of this document.  
We are not liable for any errors or omissions, as we reserve the right to change the specifications 
of the products described herein at any time and without notice, and make no warranties for 
damages resulting from corrupted or lost data due to misuse, wrong operation, or malfunction of 
the products. 
 
Microsoft®, ActiveSync®, and PowerPoint® are registered trademarks, and Windows CE™ is a 
trademark, of Microsoft Corporation in the United States and other countries. 
Compaq and Pocket PC are trademarks of Compaq Information Technologies Group, L.P. 
CompactFlash™ is a trademark of SanDiskCorporation. 
LifeView FlyCAM® is a registered trademark of Animation Technologies, Inc. 
IA Album™, IA VideoMail™, and IA Capture™ are trademarks of IA Style, Inc. 
Other names and products not mentioned above may be trade names, service marks, trademarks, 
or registered trademarks of their respective owners. 
 
No part of this document, in whole or in part, may be copied, reproduced, adapted, transmitted, 
reduced, transcribed, stored in a retrieval system, or translated into any human or computer 
language, in any form or by any means, either mechanically, electronically, or manually, without 
prior consent in writing from IA Style Inc., except as allowed under the copyright laws. 
 
The programs in the IA Style PowerCamera Suite are copyrighted and all rights are reserved.  
Reproduction, adaptation, or translation of those programs without prior written permission of IA 
Style, Inc. is also prohibited. 
 
If you have suggestions or comments concerning this publication or the products it describes, 
please tell us so that we can continue to provide you with the best possible documentation and 
functionality.  We are happy to consider your suggestions as we update and enhance this product. 
 

First Edition    July 2002 
Copyright  2000-2002    IA Style, Inc. 

All rights reserved. 
 
 
Corporate Headquarters:   U.S. Liaision Office: 
 
IA Style, Inc.    IA Style, Inc. 
5F, No. 1, Sec. 1, Duen-Hua South Road 2161 Sierra Street 
Taipei   105    Torrance, CA   90501 
Taiwan     USA 
Tel:    + (886-2) 2570-1668 
Fax:   + (886-2) 2570-0668 
 
Web sites:  http://www.iastyle.com  and  http://www.iastyle.com.tw 
Product support:  supportE@iastyle.com 
OEMs and partnerships: sales@iastyle.com 
Other inquiries:  info@iastyle.com 
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Foreword 
The IA Style PowerCamera Suite is a perfect fit for multimedia video in/output solutions 
for Pocket PCs, and organizing/annotating “still” images.  With the proper accessories, 
such as the FlyCAM® digital video camera from Animation Technologies Inc., this 
integrated software Suite gives you creative control over image/video capture and 
management.  It consists of three products: 
 

• IA Album (digital photo album manager and screen capture utility) 
• IA Capture (take snapshots and shoot video clips using your Pocket PC and 

attached camera or video source) 
• IA VideoMail (create video files, with audio, and E-mail them to your friends) 

 
Welcome to the power and convenience afforded by the natural marriage of these top-
quality Animation Technologies hardware and IA Style software products.  This guide 
introduces the IA Style PowerCamera Suite components, and tells you how to install, 
register, upgrade, and obtain technical support for them. 
 
Hardware and Software Requirements 
Before installing, please verify that you have the following hardware and software 
requirements. 
 
Supported PDA Device 
� Pocket PC or Pocket PC 2002 with CompactFlash™ slot 
� Animation Technologies’ FlyCAM®  with the latest device drivers installed 
� Storage Memory:  3.0 MB in your Pocket PC is required for installation 
� Processor:  StrongARM, MIPS, or SH3 
 
Desktop Computer 
� Windows 98, 98 SE, ME, NT, 2000, and XP 
� ActiveSync 3.5 or above 
 

In addition, if you choose to install IA VideoMail, you should also install: 
� Windows Media Player 7.x or later 

(Can be downloaded free at:  
http://www.microsoft.com/windows/windowsmedia/download/) 

� Quicktime 5.x or later 
(Can be downloaded free at:  http://www.apple.com/quicktime/download) 

 
NOTE:   IA Capture can browse for IAV files only within IA Capture on the Pocket PC, 
but IA VideoMail files (AVI files) can be viewed on the desktop PC using the above 
downloads. 
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How to Install the Language Version You Want 
Each component of the IA Style PowerCamera Suite must be installed individually.  
This allows you to control which applications you install, in the event that you don’t 
want to install all three components.  It also makes it easier for you to upgrade the 
individual modules, whenever new versions are available for you to download. 
 

1. Make sure your Pocket PC is connected to your desktop PC and that an 
ActiveSync connection has been established. 

2. Insert the IA Style PowerCamera Suite Installation CD.  There will be 
multiple language folders available on the CD, for example: 
• English 
• TC Chinese  (Traditional Chinese) 

 

3. Double-click on the desired language name to open the folder. 
4. Double-click on the desired executable filename (.exe filename extension) to 

begin installing that application. 
 
NOTE:   The following table is designed to assist you in identifying which .exe file 
corresponds to which application.  The “xx” in each Installer filename (shown in the 
right column below) is reserved to identify each language version. 
 
For example, in the first line of the table below, the actual Installer name of the English 
version of IA Album would be IAA(FlyCAM)EN.exe, and the Traditional Chinese 
version of IA Album would be IAA(FlyCAM)TC.exe. 
 

TO INSTALL THE FLYCAM 
VERSION OF THIS APPLICATION..... 

DOUBLE-CLICK ON THIS FILE NAME..... 

IA Album IAA(FlyCAM)xx.exe 
IA Capture IAC(FlyCAM)xx.exe 
IA VideoMail IAVM(FlyCAM)xx.exe 

 
Note that the filenames in the rightmost column of the table above are examples for 
reference only.  The actual filenames on your particular Installation CD might vary 
slightly. 
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5. After you have double-clicked on a filename and the Installer program has 

started, you will be asked to enter your CD-Key number.  Alphabetic 
characters must be entered in uppercase.  (The CD-Key number is usually 
found on the envelope that contained your Installation CD.)  After entering it, 
click Next for CD-Key verification. 

 NOTE:   The same CD-Key can be used for every component you install 
(any language version), and also for registering and upgrading. 

6. If you accept the license agreement, you will next be asked to specify the 
folder where you want the component to be installed on your desktop PC.  
Click Next to accept the default destination folder shown in the dialog box, 
or click Browse... to specify a different folder, if desired. 

7. Check your Pocket PC screen to see if any additional steps need to be done 
to complete the installation on the Pocket PC. 

 
 
Invoking an Application 
After you have installed one or more components of the IA Style PowerCamera Suite 
on your Pocket PC, the Programs group of your Pocket PC will contain new icon(s) 
representing the component(s) you installed.  The icon names are IA Album, IA 
Capture, and IA VideoMail.  To invoke a program, simply tap the corresponding icon. 
 
Under each icon, the hardware and language versions will be indicated.  For example, 
“FC_EN” under one of the icons would identify it as an English version to be used with 
the FlyCAM hardware.  Likewise, “FC_TC” would indicate a Traditional Chinese 
version for FlyCAM. 
 
NOTE: 
Included with the IA Album installation are some sample image files, placed in a 
subfolder named Samples (the full path is IA Style\FlyCAM\IA Album\EN\Samples).  
Change to the Samples folder (or any folder that contains images you already have).  
The images will be displayed in Thumbnail View mode. 
 
 
IMPORTANT: 
 

• Make sure the FlyCAM driver has been installed properly. 
 

• The IA Style PowerCamera Suite can be used on your Pocket PC for 30 days 
after installing the Suite, with or without the FlyCAM.  However, within any 30-
day period, the FlyCAM hardware must be attached to your Pocket PC at 
least once in order for you to use the IA Style PowerCamera Suite continually. 
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Introduction to the Three Modules of the IA Style 
PowerCamera Suite 
 
IA Album 
IA Album is the ultimate digital photo manager for your Pocket PC.  This award-
winning software allows you to view, organize, annotate, present, and share images 
quickly and easily.  Download images from your desktop PC via ActiveSync, or get 
them from your digital camera’s memory card (CompactFlash, or Secure Digital/MMC 
card). 
 
Images can be E-mailed, infrared-beamed, cropped, zoomed, and saved to different 
formats.  Animated GIF files can be played, as well as the video files created by IA 
Capture (after you convert them to GIF format).  A handy Screen Capture utility is 
included, along with a variety of attractive “picture frames” you can use to frame your 
images.  Add text, audio, and even digital Ink annotation to images, and then impress 
your friends with an automatic slide show. 
 
This newest version of IA Album is especially useful for those who own a Digital Still 
Camera (DSC) and can take their flash memory card (CF or MMC) and insert it into a 
compatible slot (CF or SD) on their Pocket PC.  The new Browse Flash Card 
command (on the File > GoTo submenu) allows lightning-fast browsing and viewing of 
images from external storage cards, and fast thumbnail browsing and viewing of 
images from external storage cards.  Many other improvements have been made, 
including a Histogram feature that lets you select which channel of the Histogram to 
view (Luminance, Red, Green, or Blue), and easily identify the bands of intensity 
ranges. 
 
In the following figures, the sample illustration on the left shows IA Album in Filmstrip 
View mode, with the Quick View window open, the Zoom tools available in the Toolbar, 
and the Zoom Slider open (at right side of screen).  The Quick View command is 
available on the View Menu when the image is too large to fit in the display area.  You 
can drag the “viewport” within the Quick View window to pan to different parts of the 
image.  The figure on the right illustrates List View. 
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NOTE:   You can visit www.iastyle.com often to get the latest version of IA Album (see 
the section entitled Registering and Upgrading).  To obtain a User’s Manual, see the 
section Getting More Detailed Information about the Software. 
 
 
 
IA Capture 
IA Capture is an image and video capture application designed to fully utilize your 
FlyCAM hardware with your Pocket PC.  The Digital Viewfinder in the upper portion of 
the screen lets you view the active video stream being input from your attached 
FlyCAM camera, and you can capture a single image snapshot from that input, or an 
entire video clip.  Still images can be viewed and manipulated immediately using IA 
Album (if you have installed it), and video files can be played back immediately using 
IA Capture. 
 
IA Capture does much more than just capture images and video.  Many amenities are 
built in.  You can choose the filetype/quality, control the playback, view file info, choose 
a method of memory management during video recording, specify a delay-time for 
capturing still images, and more. 
 
The Capture Mode screen of IA Capture is shown in the next figure, with each 
component of the screen identified. 
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Mode Indicator:  When 
Image is shown, 
tapping Capture will 
capture a “still” image.  
Tap the word Image to 
switch to Video 
Capture submode. 

Full-Screen Preview 

Self-View ― Toggles 
image in ViewFinder 
upside-down or right-
side-up. 

Image Quality 
adjustment 

Exit 

Minimize 

On-line Help 

Opens a screen that 
allows you to set 
attributes and 
customize the behavior 
of IA Capture. 

Tap to switch to Video 
Playback mode. 

In Image Capture 
submode, tap to 
capture a “still” image.  
In Video Capture 
submode, tap to start 
recording a video clip.  
(You can optionally 
assign a hardware 
button to trigger the 
Capture function.) 

Invokes IA 
Album in 
Thumbnail 
view mode 
(if 
installed).  
Your 
captured 
images will 
be shown 
as thumb-
nails. 

Invokes IA 
Album in 
Full Screen 
view mode 
(if installed) 
and allows 
you to view 
captured 
images on 
the full 
screen. 

Allows you to change the 
“color space” from the 
default YUV to RGB and 
back.  Affects the Image 
Quality Adjustment 
function.  When RGB is 
active, the Pixel Format 

icon looks  t like his:   

Time-delay for Image 
Capture.  Set the 
Indicator to 1 to 15 
seconds, then tap 
Capture to start the 
countdown. 

Digital ViewFinder (Image Preview Area) ― Images coming in through your attached 
FlyCAM will be shown here.  This area can be switched to Full-Screen mode. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When in Video Capture submode, the Mode Indicator icon will display the word “Video,” as shown 
in the example below.  You can tap any value in the icon to change it. 
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To capture a “still” image: 
Make sure you are in Image Capture submode.  Then tap the Capture button to 
capture a snapshot of the image that is displayed in the Digital Viewfinder at that 
moment.  Or, if you have defined one of your Pocket PC buttons to function as the 
Capture button (in the General tab of Options), press that button to perform the 
capture.  A camera-like sound effect will indicate that the image has been saved as a 
separate file.  It will be placed in the current folder.  If desired, you can change the 
“save folder” and/or the filenaming convention using the File tab of Options. 
 
To capture an entire moving video stream: 
Make sure you are in Video Capture submode.  To start recording the video stream 
which is currently shown in the Digital Viewfinder, tap the Capture icon.  A red dot will 
appear within the Mode Indicator icon, to indicate that recording is in progress.  In 
addition, a time counter will appear and will start counting the number of seconds that 
have elapsed during the current recording.  During the time that the recording is in 
progress, the Capture button becomes a Stop button.  To stop recording, tap Stop.  
The video clip will be saved as a proprietary format Motion-JPEG video file.  The file 
will contain an extension of .iav and will be placed in the folder that is currently 
designated as your “save folder.” 
 
Converting an IAV Video Clip to GIF Animation Format 
IA Capture saves video clips in a proprietary Motion-JPEG format called IAV (IA Video), 
which can be viewed on any Pocket PC running IA Capture.  For increased portability, 
IA Capture also provides a feature that lets you convert the IAV files into GIF 
(Graphics Interchange Format) files.  This cross-format solution lets you more easily 
share files with anyone who does not have IA Capture, or just view them on your 
desktop PC if desired.  Only a copy of the IAV file is converted.  The original IAV file 
remains unchanged. 
 

1. In the Video Playback screen, tap the thumbnail image of the file you want 
to convert. 

2. Open the pop-up menu by tapping the Menu Commands button (or by 
pressing your stylus on the thumbnail image or on the upper display area). 

3. Select Convert to GIF Format....  A screen will appear in which the name 
of the selected file to be converted , and the folder it is located in, will be 
displayed. 

 
Optional:  If you want the new GIF file to be placed in a folder other the one shown in 
the Folder field, tap the Folder button.  A screen will then appear which lets you 
navigate to and select the folder where you want the GIF file to be placed. 
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4. A default filename for the GIF file is shown in the Convert To text box.  If 

desired, you can assign a different prefix to the new .gif file.  After deciding 
on the filename, tap the Convert button to create a copy of the IAV video 
file in the GIF format.  This may take a moment, depending on the size of 
the original IAV file.  A dialog box will appear and display the progress of 
the conversion. 

 
Moving and Viewing the GIF File 
 
On Your Pocket PC: 
If you have IA Album, no need to move the file ― you can play the GIF file on your 
Pocket PC immediately using IA Album.  In addition, you can conveniently E-mail the 
GIF file or Infrared-beam it to your friends, right from within IA Album. 
 
On Your Desktop PC: 
You can use Microsoft ActiveSync to move the converted GIF file from your Pocket PC 
to your desktop PC.  Or, just move the CompactFlash media and read it via a CF 
memory card reader.  After the GIF file is on your desktop PC, you can drag-and-drop 
it from the File Explorer window into any web browser window, such as Internet 
Explorer or Netscape.  The GIF file will automatically be played in the web browser 
window.  To re-play the file, use the Refresh function of the web browser.  Many 
popular image viewers can also be used to view the file. 
 
NOTE:   You can visit www.iastyle.com often to get the latest versions of IA Capture 
and IA VideoMail (see the section entitled Registering and Upgrading).  To obtain a 
User’s Manual, see the section Getting More Detailed Information about the 
Software. 
 
 
IA VideoMail 
With an attached FlyCAM or other compatible digital camera (and proper driver), IA 
VideoMail can capture video clips with audio and can E-mail the video files to other 
users.  Users receiving your E-mailed video clips can view them on another Pocket PC, 
or on a desktop PC running Microsoft Windows, or MacIntosh, capable of playing 
DSC-produced video clips in the popular M-JPEG format. 
 
Each time IA VideoMail is initially invoked, it is in “Preview Mode” and is looking for 
input from an attached camera or other video source.  Any live video stream being fed 
from the camera or other source can be seen in the Viewing Area.  (All parts of the 
main IA VideoMail screen are identified in the next figure.)  Simply tap the Record 
button to begin recording, and tap the Stop button to stop recording. 
 
Tap the E-Mail button to open a dialog box that lets you easily send the current video 
file as an attachment. 
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After you have captured a new video clip (or loaded an existing video file), it will be 
visible in the Viewing Area.  Newly-captured video clips can be played back 
immediately.  Tap the Play button to begin playback (and tap it again if you wish to 
Pause the playback). 
 
If the current video clip has not been saved, you will be asked to either save it or 
discard it, if you attempt to perform any other function such as loading a file. 
 
Tap the Menu Commands button to open a menu that lets you load an existing video 
file, save a new video clip, view file info about the current video, on-line Help, etc. 
 
Tap the Options button to open a screen that lets you specify the size for captured 
video files, Color or Grayscale, a voice recording format, frame rate/memory 
management during recording, and image quality adjustment. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Viewing Area ― Images coming in through your attached 
FlyCAM camera (or video-in channel) will be shown here. 

This indicator moves 
during automatic playback, 
but you can also drag it 
manually to play forward 
or reverse at any speed. 

LCD Panel ― Preview 
Size is shown at top.  The 
lower area can be tapped 
to view size of current 
video clip, total number of 
frames, and frames per 
second.  An audio icon 
indicates the file includes 
audio.  The colored dot will 
be red when recording and 
green during playback. 

On-line Help 

Minimize 

Exit program 

Stop recording 
or playback 

Play the 
current video.  
During 
playback, it 
changes to a 
Pause icon: 
 

 

E-Mail t
attachm
that sho
To, Cc, 
lets you 
via wirel
available

Tap to toggle between a 
Time Counter and Frame 
Counter.  (Time Counter 
is shown here.) 

Image Quality 
Adjustment ― adjusts 
Brightness, Contrast, 
Saturation, and Hue. 

Self-View ― Switches 
image in ViewFinder 
upside-down. 

Record ― Tap to 
begin recording (if 
video input is 
detected). 

Page 12 IA Style PowerCamera Suite Installa
Opens the Options 
screen, which allows 
you to specify various 
settings for the 
behavior of IA 
VideoMail
he current video as an 
ent.  Opens a dialog box 
ws file info; lets you enter 
Subject, and Content; and 
send via ActiveSync or 
ess connection, if 
. 

Drag up or down to 
adjust Volume. 

Opens a menu that 
lets you Load or 
Save videos, etc. 

tion Guide ― July 2002 



IA Style PowerCamera Suite ― Installation Guide 
 

 

Registering and Upgrading 
At IA Style, we are continually improving our products and adding new functionality.  
Whenever a newer version of a module in the IA Style PowerCamera Suite is available, 
we will announce it on our web site.  Registered owners of IA Style PowerCamera 
Suite can then update the program free of charge. 
 
To Determine Your Version of a Program 
If you see a new version on our web site of a program in the IA Style PowerCamera 
Suite, and you want to know the version of the program you are currently using so you 
can determine whether or not you have the newest version, just open the About 
screen of any of the programs, as follows: 
 

• IA Album ― Tools Menu > About IA Album 
• IA Capture ― Options button > About tab 
• IA VideoMail ― Options button > About tab 

 
 
To Register as an Owner of IA Style PowerCamera 
Suite 
 

1. Go to our home page at http://www.iastyle.com.  Click the Bundled 
Products tab at the top of the page. 

2. In the list of links on the left side of the page, click IA Style PowerCamera 
Suite (for FlyCAM) to access its main page. 

3. Click Register in the links on the left side of the page. 
4. On the Registration page, please enter your CD-Key number.  This number 

is usually found on the envelope that contained the Installation CD for IA 
Style PowerCamera Suite.  (Alphabetic characters must be entered in 
uppercase.) 

5. Enter the E-mail address that is currently entered in the Owner Information 
of your Pocket PC (Start Menu > Settings > Personal > Owner Information). 

6. Enter your name. 
7. Select the language of your FlyCAM software from the drop-down list. 
8. Select the model of your Pocket PC from the drop-down list. 
9. Click the Registration button.  We will send you E-mail to confirm that you 

have registered successfully. 
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To Update Your IA Style PowerCamera Suite Software 
After you have registered as a legitimate owner of IA Style PowerCamera Suite as 
described above, you can download upgrades as follows: 
 

1. Go to our home page at http://www.iastyle.com.  Click the Bundled 
Products tab at the top of the page. 

2. In the list of links on the left side of the page, click IA Style PowerCamera 
Suite (for FlyCAM).  Any new versions of IA Style PowerCamera Suite 
(for FlyCAM) components will be announced on its main page. 

3. If you see a software update or upgrade that you want to download, click 
Download. 

4. On the Download page, you must first log in.  Please enter your CD-Key 
number.  This is the same CD-Key number (located on the envelope that 
contained your Installation CD) that you furnished to us when registering.  
Note that all letters must be entered in uppercase. 

5. Or enter the E-mail address that you used when registering (must also be 
the E-mail address that is entered in the Owner Information of your Pocket 
PC, in order for the IA Style software to work). 

6. Click the Login button.  You will then be given access to download the 
software.  Just follow the instructions on that page. 

 
 

Technical Support / Contact Info 
 
FAQ Pages 
We recommend that you first browse through the “Frequently Asked Questions” pages 
if you have questions.  These pages are continually being updated, and there is a good 
chance you will find the answer to your question there. 
 
Each component of the IA Style PowerCamera Suite has its own individual FAQ page.  
Start by going to our home page at http://www.iastyle.com, then go to the desired 
product’s main page and click on its FAQs link. 
 
In addition, you can go to LifeView’s FlyCAM page at:  
http://www.lifeview.com.tw/english/flycam-cf_e.asp to read more information about the 
FlyCAM hardware and other products from Animation Technologies, Inc. 
 

Page 14 IA Style PowerCamera Suite Installation Guide ― July 2002 

http://www.iastyle.com/


IA Style PowerCamera Suite ― Installation Guide 
 

 
Getting More Detailed Information About the Software 
 
User’s Manuals 
User’s Manuals for the entire IA Style PowerCamera Suite, and for the individual 
applications that comprise it, can be found on the Installation CD, or can be 
downloaded from our web site.  To see the User’s Manual for IA Style PowerCamera 
Suite in general, go to www.iastyle.com, click the Bundled Products tab, then click 
the IA Style PowerCamera Suite (for FlyCAM) link on the left side of the page, then 
click the User Manual link. 
 
Also, each component of the IA Style PowerCamera Suite has its own individual page.  
Just go to the desired product’s main page and then click on its User Manual link to 
access its individual Manual. 
 
 
On-line Help 
Many of your software operation questions can probably be answered by the on-line 
Help messages included with each module. 
 

• When using IA Album, you can select Help... from the Tools Menu to access 
the main Help table of contents. 

• In IA Capture, tap the “?” icon, or select Help... from the pop-up menu in the 
Video Playback screen. 

• In IA VideoMail, tap the “?” icon, or tap the Menu Commands button and 
then select Help... from the pop-up menu. 

 
Context-Sensitive Help 
Context-sensitive Help messages can be accessed via the Windows Start Menu.  That 
is, the specific Help message that appears will depend on the IA Style application’s 
operation status at the time you select the Help command on the Windows Start Menu. 
 
 
Contact Information 
If you still have questions about the IA Style PowerCamera Suite after consulting the 
FAQs and other information on the web sites, the User’s Manuals, and the on-line Help, 
you are welcome to contact us at the addresses listed on page 2. 
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